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SPSS:  An Introduction 
(Revised August 2013) 

 
Welcome to your first experience with SPSS (Statistics Package for the Social Sciences).  I hope you find this 
packet useful as you begin to navigate your way through this statistics software package.  You should save the 
documents on SPSS that I distribute in class as you will find them useful to refer to throughout the semester and 
during your future career in the Psychology Department! 
 
Overview 
This handout will walk you through the following steps: 

 

1.   Using the Citrix server and launching SPSS. 
2.  Downloading a data file from Blackboard to the desktop and uploading it to your SSS space. 
3.   Opening your file in SPSS. 
4. Creating a data file in SPSS. 
5. Conducting basic statistical analyses using SPSS. 
 
PART 1:  Linking to the Citrix Server to Access SPSS 
 

SPSS 21 for Windows is available via the Citrix server on any computer on campus, Macintosh or Windows. 
Consequently, you will be able to use SPSS in your dorm room via the Citrix server. You will need to know your 
username and password for linking to the Citrix server, which should be the same as your email username and 
password. The first time you use Citrix, you’ll need to register (it’s free).  (A variety of software packages are 
available through the Citrix server.  ITS also has separate documentation that introduces the Citrix server and 
explains how to access these programs on the server.) 
 
1. Open your web browser and enter the following address: http://citrixweb.hamilton.edu/.  The Citrix 

Metaframe window will open and prompt you for your username and password, which should be the same 
as your email username and password (see Fig. 1). After you type these, select the appropriate Domain: 
“students.hamilton.edu” and click on “Log In,” and the computer will bring up a new window (see Fig. 2).   

 

                                                    
Figure 1                                                                        Figure 2 
 
2.  Once you register, this window presents a view of the available software packages you can access through 

the Citrix server.  You will be using SPSS 21.  Find the correct icon and click on it. 
 

3. You will see a task progress window indicating that the application is starting.  After a short lag (this could 
take up to 30 seconds or more), SPSS 21 should be open and you can navigate to the file you wish to open 
if it is on your SSS (or create a new one).  

 
PART 2: Downloading the data file to the desktop and uploading it to you SSS space 
1.   Open your web browser to the “My Hamilton” web page at the following address: 

(http://my.hamilton.edu/myhamilton/login.cfm). 
 
2.   Log in using your email username and password. 
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3.   Click on the “Courses” tab, and in the column under “My Blackboard Courses,” click on the link to our 
course. The Blackboard page for our class will open.  

 
4. Click on “Assignments” and you will see an item labeled “Class data file” with a link to a file called 

Class_data.sav.  Click on the Class_data.sav link, and you will be prompted to save the file.  You can either 
temporarily store the file to your local computer’s desktop and then upload it to your SSS (via the “Files” tab in 
the My Hamilton portal or by accessing the sever directly) or you can save it directly to your SSS if you are 
logged in at the time.  In your SSS is a folder called “Citrix” (it gets created the first time you open SPSS using 
Citrix) and within that folder is a subfolder named “Documents.”  Here is where you want to store all of your 
data files (see Figures 3 and 4 below). 
 

    
Figure 3       Figure 4 
 
PART 3: Opening SPSS and Saving your Data File to Your SSS Space 
 
When SPSS is first opened, it will prompt you with the following window: 
 

 
Figure 5 
 
For the class data set, you are using an existing data file, so click OK to the default selection of “Open an 
existing data source.”  A window will open to allow you to navigate to the pre-existing data file (see Fig. 6). 
 

 
 Figure 6 
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The default in SPSS when you choose to open a file is to take you to the Documents subfolder within the Citrix 
folder on your SSS, which is why it is so important to upload any data files to this folder in your SSS before 
opening SPSS. Find the file that you uploaded from Blackboard, “Class_data.sav.” Click on the file and then 
click “open.” The data file will open in SPSS. 
 
Saving files 
Be sure to save frequently so you don’t lose your work due to unforeseen circumstances. When you are finished, 
you should save it again to your SSS space. To do so, click on File in the SPSS menu bar, then Save As.  A 
window similar to that shown in Figure 6 will appear showing the contents of your SSS folder.  Name your file 
with a meaningful, informative label, then click ‘Save.’  A copy of your file will be saved in your SSS folder.  
 
In Part 4 below are instructions about how to create a data file, which you will need to do for future homework 
assignments. In Part 5 are instructions for how to perform basic descriptive statistics on your data.  Save these 
documents for future reference!! 
 
PART 4: Creating a data file in SPSS 
 
When you open SPSS, one of your choices is “Type in data” (see Fig. 5, above). If you click that option, you will 
be presented with an untitled data file (see Fig. 7). Note that this file looks like a standard spreadsheet.  
 

 
Figure 7 
 
Before you can analyze your data, you must first input them into this file. Notice that the rows are already 
numbered and the columns are labeled “var.”  At this stage, they are shaded blue because they have not been 
activated with data or variable names. 
 
As you get familiar with the format of this spreadsheet, you should recognize that each column represents a 
variable and each row represents a participant’s data for each variable. So each row represents the scores from one 
particular participant.  
 
Before entering your data into this data file window, you’ll need to do a couple things. First, you need to figure 
out what you’re going to call each variable, keeping in mind that SPSS won’t let you begin a variable name with a 
number or use special characters, such as spaces. Next, you need to figure out what sort of information you’ll 
enter for each variable. In some cases, both of these decisions might be easy; but in other cases, more thought 
might be required. For instance, if one of the variables that you want to enter is the gender of the participant, you 
can’t enter the words “male” and “female”; instead, you need to develop a code (a way to quantify the variable). 
So, you might decide that for the variable “gender,” you will use a “1” to represent males and a “0” to represent 
females. Of course, for some variables (e.g., age), you won’t need a code, but will simply enter in the value the 
participant writes down.  
 
Define each variable 
SPSS has two different screens or “views”: data view and variable view. In data view, you see the basic 
spreadsheet depicted in Figure 7. In variable view you can easily name and define your variables (see Fig. 8). You 
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can toggle back and forth between these two views by clicking on the appropriate button (see bottom left of the 
screen).  
 
We recommend that your first variable always be participant ID (an arbitrary number you assign to each 
participant for record-keeping purposes). Below is an illustration of the variable view with the first variable 
added. Notice the variable label (Participant ID Number) in the “label” column. 
 

 
Figure 8 
 
Let’s say that you wanted your second variable to be participant gender. As with participant ID, you need to 
provide a variable name (a short name, e.g., “gender”) and a variable label (a description of the variable to 
remind yourself of what the variable is; e.g., “participant gender”). For this variable, though, you’ll need to 
provide value labels to indicate what different levels of your variable mean. To do so, simply click in the 
appropriate cell in the “values” column (i.e., the cell that appears in the “gender” row). A lightly shaded blue box 
appears within the cell, and if you click on it, a large dialog box appears in the middle of the screen (see Fig. 9). 
See how we’ve indicated that “1” represents male participants and “0” represents female participants? You can 
simply type the value in one box and the value label in the box beneath it. Then click on “Add.” Once you’ve 
added all your values and value labels, click “OK.” 
 

 
Figure 9 
 
Determining the number of decimal places each variable has 
In addition to giving your variable a label and defining its values, you may find it convenient to choose the 
number of decimal places you want displayed for each variable. For instance, if your variable is “gender,” and the 
values are “1” and “0,” it may annoy you to have SPSS display “1.00” and “0.00” all the way down the column 
(the default is 2 decimal places). To change the number of decimal places displayed, simply click on the 
appropriate cell (e.g., the one in the “gender” row and the “decimals” column). Up and down arrows appear in the 
right-hand part of the cell, and you can simply click on the down arrow until you have 0 decimal places (or you 
can type “0” directly).  
 
Repeat this process of defining and labeling for all of your variables.  NOTE: You’re not entering any of the 
participants’ data yet; you’re only getting the data file set up by creating and labeling the variable columns.  
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Entering the data 
Once you’ve defined all the variables you need, you’re ready to enter the actual data. Generally, it’s easiest to 
enter all the data from a single participant before moving on to the next participant. That is, work row by row. 
 
Just for illustrative purposes, in Figure 10 you see the first portion of a sample questionnaire data file, showing 12 
participants and their scores on the first several variables of a questionnaire.  
 

 
Figure 10 

 
Checking for errors 
This is one of the most important steps of entering and analyzing data. If you made any errors inputting the 
numbers, it could wreak havoc with your analyses and your interpretation of the data. If the errors are big or 
numerous, it could mean the difference between supporting and rejecting a hypothesis! Be VERY CAREFUL 
whenever you enter data, and always double-check everything.  
 
PART 5: Conducting Basic Statistical Analyses Using SPSS 
 
Exploring your data 
Now you’re ready to start taking a look at your data. Below are described some of the descriptive statistics or 
graphing options you might be interested in using. Later in the semester we’ll discuss how to use more advanced 
techniques (e.g., t-tests, ANOVAs, correlation & regression).  Before running any analyses, click on the Edit 
menu then scroll to the bottom and select “Options.”  A window will appear where you will be able to tell SPSS 
that you want the Variable Lists in any analysis window to display the names of the variables (the default in SPSS 
is to display the labels, which can be cumbersome). 
 

The “frequencies” command 
If you want the computer to print you a frequency distribution, go under the “Analyze” menu, scroll down 
to “Descriptive Statistics,” and then choose “Frequencies.” You’ll get a window like the one in Figure 11.  
 

 
Figure 11 
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On the left side is a list of all the variables in your data file. Simply click on one you want to examine, 
then click the arrow.  
 

TIP:  You can select multiple variables at the same time by holding down the <Control> key 
while clicking on the variable names with the mouse, and then click the arrow. Alternatively, if 
the variables you desire are listed in sequence in the data file, you may click on the first variable, 
hold down the <Shift> key and click on the last variable in the list that you want to examine, and 
then click the arrow.   

 
Once you’ve selected the variables you’d like to examine, you need to decide what information you’d 
like. The default is just the frequency tables (notice the check mark in the box labeled “Display frequency 
tables”). If you don’t want frequency tables, you can click on the box to remove the checkmark. If you 
click on the “Statistics” button, you can choose which measures of central tendency & variability you 
want to use. REMEMBER: You need to figure out what level of measurement a particular variable 
represents before willy-nilly choosing statistics. For example, calculating a mean gender doesn’t make 
any sense, because gender is measured on a nominal scale. THE COMPUTER IS STUPID AND WILL 
DO WHATEVER YOU TELL IT TO DO, EVEN IF YOU TELL IT TO DO SOMETHING WRONG! 
So you have to make sure to choose your statistics wisely. 
 
Histograms & Bar graphs 
If you want to look at your data graphically, you might choose to have SPSS draw you a histogram or a 
bar graph of a particular variable. Remember, histograms are used for quantitative variables (e.g., height), 
whereas bar graphs are used for qualitative variables (e.g., gender). Simply click on the “Charts” button 
within the frequencies command and choose which type of graph you want.  
 
The “Descriptives” command 
Another way to get basic descriptive statistics is to go under “Analyze,” “Descriptive Statistics,” 
“Descriptives.” Here you’ll get mostly the same options as with the “Frequencies” command, only you 
won’t get a frequency table. 
 

Moving back and forth between the data window and the output window 
Whenever you ask SPSS to calculate something for you, you automatically get bumped into the output window 
(“SPSS viewer”) where the output from your commands (e.g., frequency tables, descriptive statistics, graphs) is 
displayed. To get back to the data window, simply go up to the “Window” menu, and scroll down until you see 
the name of the data file. If you want to edit a graph, double-click on it in the output window and you will be 
bumped into the “Chart Editor.” Again, you can return to any other window by going up to the “Window” menu.  
 
Save, Save, and Save Again! 
We strongly recommend saving your data file and output file every couple of minutes. You don’t want to lose 
hours of work in case of a computer crash or power outage. Save frequently. 
 
Printing Output 
Unfortunately, SPSS output prints out in a ridiculously large font with very little information on each page. 
Printing output “as is” wastes a lot of trees. Whenever we ask you to print output for assignments, please do the 
following: From within the output window, go to the “File” menu and choose “Export”. You will see the window 
below (Fig. 12). Choose “Word/RTF(*.doc)” as the type (which is the default), click “browse” to decide where to 
save the file (the default is the Documents subfolder of the Citrix folder on your SSS), give the file a descriptive 
name, and click OK on the Export window. You can now open the saved file in Microsoft Word, reformat the 
tables if you wish, delete any unnecessary information, and then print your output.  
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Figure 12 
 
To save paper, you should print four pages to a sheet. To do so on a Macintosh, select “Print” from the “File 
menu.” Under the “Copies and pages” pull-down menu, change the setting to “Layout,” and change “Pages per 
sheet” to 4 (see Fig. 13): 
  

 
Figure 13 
 
Play around! Explore! Have fun! 
SPSS is a fairly user-friendly program. If you get lost, simply scroll around in the menus until you find what 
you’re looking for. If you’re really lost, you can also use the on-line help by going up to the “Help” menu and 
clicking on “SPSS Help.”  
 
Remember, SPSS will blindly do whatever you tell it to do, regardless of whether or not it’s a sensible command. 
So be smart about what you tell it to do! 
 
Now you’re ready to explore your data. Enjoy!  
 
Part 6: Ending your session with CITRIX 
 
When you are done working, remember to save any of your work to your SSS folder.  Then, from the Citrix client 
File menu select quit.  This will also automatically quit the SPSS session.  You will also need to log out of Citrix 
from your web browser. 
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